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1
1.   Setup and System Initialization
This chapter describes the following topics:

•     Minimum System Requirements 
•     What’s in the Package 
•     Software Installation 
•     Setting Up the Adapter 
•     Positioning the PC Adapter 
•     Positioning the HD Base 
•     Icon Descriptions 
•     LED Descriptions 
•     Universal Push2TV HD Manager 
•     Configuring the Display 
•     Supported Resolutions 
•     The Universal Push2TV HD TV Adapter Does Not Turn On 
•     The Universal Push2TV HD TV Adapter Shows a “Ready to Connect” Message 
•     Driver Information 

Minimum System Requirements 

Note:  These minimum requirements are for streaming a high-resolution 
movie on a high-resolution screen. Movie and screen resolutions 
can be lower than 1080p when you do not require as much 
resolution.

For best performance, NETGEAR recommends the following minimum system requirements:

•     Laptop or PC with USB 2.0 port available.
•     Microsoft Windows XP SP3 (32 bit), or Microsoft Windows Vista SP2 (32 or 64 bit), or 

Win7 (32 or 64 bit).
•     HDTV, display, or projector with HDMI port.
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•     System configurations that include more than one graphic card are currently not 
supported.

•     Surround audio is supported through HDMI or optical S/PDIF input to home theater or 
speaker system.

For Windows XP: 

•     For office use, web browsing, and so on: 1.6 GHz Atom or Celeron processor and  
512 MB memory.

•     For 720p / full screen video: 1.8 GHz Core2 Duo processor and 1 GB memory.
•     For 1080p / full screen video: 2.4 GHz Core2 Duo processor and 2 GB memory.

For Windows Vista or Windows 7: 

•     For office use, web browsing, and so on: 1.6 GHz Core Solo processor and 1 GB 
memory. Overall WEI score 3.0 or better.

•     For 720p full screen video: 1.8 GHz Core2 Duo processor and 1 GB memory.  
Overall WEI score 3.5 or better.

•     For 1080p full screen video: 2.4 GHz Core2 Duo processor and 2 GB memory.
•     Video card: Intel GMA X4500, ATI Radeon HD3xxx, NVidia GeForce 9xxx or better. 

Overall WEI score 4.5 or better.

What’s in the Package

The package includes:
7
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Software Installation 

Before You Install
Before you install the software, be aware of the following:

•     If your PC contains a previous Universal Push2TV HD Suite driver installation, be sure to 
perform a correct uninstall procedure using the Windows Control Panel.

•     The installation software requires .NET Framework version 2.0 (or later) to be installed on 
the computer. 

If this software is not installed, you can download it from the following location: 

http://www.microsoft.com/downloads/details.aspx?FamilyID=
0856EACB-4362-4B0D-8EDD-AAB15C5E04F5&displaylang=en

•     Anti-virus software set to very high security might prevent the installer from running. The 
user account should be set to lower security settings during installation and restored to 
high security settings once the installation is complete. NETGEAR also recommends that 
you temporarily disable the anti-virus software during installation.

•     The installation checks the PC capabilities and compares them to the minimum system 
requirements of the system. For Vista and Windows 7, NETGEAR recommends that you 
run WEI (Windows Experience Index) calculation prior to installation.

Installation Steps:

1. Make sure that the PC Adapter is unplugged from the PC. 
2. Log in as Administrator, and insert the installation CD in the PC CD ROM drive. 
8
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The installation CD Autoplay menu displays.

3. Select Install Universal Push2TV HD Software. 

4. The Install Wizard begins installing the Universal Push2TV HD software. The installation 
process can include more than one step to accommodate several drivers that are installed.
9
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5. Select your geographic region to comply with your local radio regulations. 

This setting can be changed, if needed, once the software is installed.

6. Follow the on-screen instructions, and click Next> when prompted, or by approving 
authorization requests to continue the installation. 
10
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7. Once the audio driver and application driver are installed, the following message displays: 

8. When the installation procedure has successfully finished, you are automatically returned to 
the opening screen of the AutoRun menu. You might be requested to reboot. 

Setting Up the Adapter 

Connect the HD Base
1. Attach the HD Base Adapter to the remote display device (TV, projector, or monitor), 

using the HDMI cable, and make sure that the PC (with a PC Adapter attached) is within 
3 meters (10 feet) distance from the HD Base Adapter for initial connection. 

2. Make sure that the two Adapters, PC and Device have a clear line of sight. 
3. Connect the provided power supply to the HD Base Adapter power receptacle.

Connect the PC Adapter to the PC
1. Connect the Universal Push2TV HD PC Adapter to a high-speed PC USB port. The 

system will automatically detect and install the drivers. 

2. Wait for the System Tray icon to turn green , indicating that a wireless connection with 
the Universal Push2TV HD adapter has been established. 
11
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The Display  and Audio  icons also display as soon as a connection is established. 

Note the following:

•     If you do not see the icon changing to green, verify the line of sight between the adapters.
•     If you do not see the Display icon, refer to Chapter 3, Video, or try the suggestions in 

Service Activation on page 35.
•     If you do see the green icon and Display icon, but do not see a picture on your TV, see 

The Universal Push2TV HD TV Adapter Does Not Turn On on page 31 or The Universal 
Push2TV HD TV Adapter Shows a “Ready to Connect” Message on page 31.

Connecting Audio
The following options can be used to connect an audio output device to the HD Base: 

Using the HDMI Connector

Connect the HDMI cable to the HD Base. Both video and audio are supported when you use 
the HDMI cable. 

Connect the other end of the HDMI cable to the appropriate HDMI port on the TV, projector, 
or monitor for stereo audio, or to an available port in a home theater system for surround 
sound. For this configuration, the home theater system should support HDMI output to be 
connected to the TV, projector, or monitor. Verify that the receiver is configured to the correct 
input.

Using the Optical S/PDIF Connector

Connect the S/PDIF cable to an available port in a home theater system for surround sound. 
Verify that the audio receiver is configured to the correct input. 

Using the Dedicated 3.5 mm Port

Connect an audio cable with a 3.5 mm (mini stereo) plug to the audio jack on the HD Base 
(green color). Connect the other end of the audio cable to the appropriate audio input jack on 
the TV, projector, or monitor speaker system. This port supports stereo audio only.
12
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Note:  The audio output is activated automatically. If you need to set the 
audio output device manually, see Setting Audio Output Device on 
page 67.

Positioning the PC Adapter

To achieve best performance, NETGEAR recommends that you position the PC Adapter in 
the upright position. 

Positioning the HD Base

The Universal Push2TV HD TV Adapter is designed for two possible mounting options: 

Simple table placement: The HD Base is placed on a flat horizontal surface, and the TV 
Adapter is connected at 90 degrees relative to the base so that the TV Adapter is in a vertical 
position, as shown in this drawing:
13



Push2TV HD Adapter 
Vertical mounting: The Base is fastened to a wall or a projector, or behind a display screen, 
and the TV Adapter is connected so that it is flat with the mounting surface, with the TV 
Adapter pointing upwards. 

IMPORTANT:

Leave the top side of the TV Adapter unmasked for best radio 
performance: 

Note:  For best performance, NETGEAR recommends that you always 
position the TV Adapter vertically so that it is pointing upwards. 

Icon Descriptions 

Universal Push2TV HD Manager User Interface
The Universal Push2TV HD Manager allows you to monitor and control the available 
Universal Push2TV HD devices and connections that are within the PC’s range. 

Universal Push2TV HD Manager System Tray Icon
The Universal Push2TV HD Manager icon is automatically displayed in the Windows System 
Tray whenever Windows starts.

In Windows 7, it might be hidden, and you will need to open the System Tray in order to see 
it. 
14
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The color and shape of the icon indicates the current activity state, as shown in the following 
table:

Icon Color Status

Host Hardware Disconnected (gray icon) 
Universal Push2TV PC Adapter is not connected. 

Host Hardware Enabled (red icon) 
Universal Push2TV PC Adapter is connected to the PC (PC 
Adapter is enabled), but wireless connection is not active. 

Connected (green icon) 
A wireless connection is established with a Universal 
Push2TV TV Adapter. 

 Universal Push2TV HD Channel is Busy (green icon with 
exclamation) 
Low channel quality detected, but at least one Universal 
Push2TV HD device is still connected. For information 
about how to improve connection quality, see Channel Busy 
on page 39. 

Universal Push2TV HD Channel is not available (red 
icon with exclamation) 
No available channel detected. For information about how 
to improve connection quality, see Channel Busy on 
page 39.

 

Host Hardware Disabled (gray icon with X) 
Universal Push2TV PC Adapter is disabled. 

LED Descriptions 

The LEDs allow you to see the operational status of the Universal Push2TV adapter.

Power: 

•     OFF when no power is applied or the adapter is not connected to a USB port.
•     ON when power is applied and a wireless connection between the PC Adapter and the 

TV Adapter is not established.
15
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Traffic:

•     Rapid flashing when data is received or transmitted.

Universal Push2TV HD Manager

Context Menu Options

Accessing the Universal Push2TV HD Manager

To access the Universal Push2TV HD Manager, right-click the Universal Push2TV HD 
Manager System Tray icon  and select Universal Push2TV HD Connections to display 
the Universal Push2TV HD Manager screen. 
16
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Context menu options

Menu option Description

Universal Push2TV HD 
Manager 

Displays the main user interface, which displays a list of Universal Push2TV HD 
devices that are available, and their connection status (Connected, Not 
Connected, Blocked) 

Optimize Performance Reducing the output resolution has been found to be a good solution for 
improving performance on weak platforms as it requires much less processing 
power from your platform. Therefore, for platforms that do not meet the 
recommended minimal requirements, the output resolution when you first start up 
your system is reduced, but the overall video experience has higher FPS and is 
less jerky. By default, this option is enabled, and NETGEAR strongly suggests 
that you do not change this configuration.

User Manual Opens the User Manual (in PDF format) in a browser.

About Displays the About screen, containing version information for the drivers and 
software.

Exit Closes the Universal Push2TV HD Manager application.
17
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Universal Push2TV HD Manager Options

Universal Push2TV HD Manager Options

Menu option Description

Push2TV Adapter 
MAC Address

Displays the currently connected PC Adapter MAC address.

Connection Quality The following are the different states of the connection status icon, 
which indicate the connection quality:

Blocked                                           

Not connected                                

Connected                                     

Medium                                          

Good                                             

Very Good                                     

Excellent                                       

Advanced Settings Displays the Advanced Settings screen, and allows configuration of the 
PC Adapter Radio settings.

Close Closes the Universal Push2TV HD Manager screen; does not close the 
Universal Push2TV HD Manager application.

About Displays the About screen containing basic information about the 
software version and vendor details.
18
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PC Adapter Names

Changing PC Adapter Names in the Universal Push2TV HD Manager

The Universal Push2TV HD Manager screen allows you to modify the name of the PC 
adapter that displays in the connections list. 

To modify the PC adapter name:

1. Double-click the PC adapter name. 
2. Enter the text that you want.
3. Click anywhere outside of the device name area to finalize.
19
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Advanced Settings
The Universal Push2TV HD Manager’s Advanced Settings screen allows the configuration of 
the Channel and Region selection in the host. To access the Advanced Settings screen: 

In the Universal Push2TV HD Manager screen, click Advanced Settings.

Option Description

Region Allows selecting the regulatory region: USA, Europe.

Current Channel (read only) Displays the current radio channel.

Channel Quality (read only) Displays channel quality: Excellent, Very Good, Good, Low, Not Connected.

Select Channel Allows selecting radio channels: 13, 14, 15

Run Generates diagnostics output.

Clear Clears previously generated diagnostics output.

Apply Applies configuration changes that were made.

Close Closes the Advanced Settings screen.
20
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Blocking or Disassociating

Blocking or Disassociating a Device

The Universal Push2TV HD Manager screen allows you to remove devices or to temporarily 
disable them from connecting to the PC Adapter. To block a device temporarily, and prevent it 
from connecting to the PC Adapter, right-click the device name in the Connection list, and 
select Block Device. 

Universal Push2TV HD Manager Context Menu

To remove a device from the list of available devices completely, right-click the device name 
in the Connection list, and select Disassociate Device. 

Note:  The Disassociate Device option is available only for TV Adapters 
that are purchased separately and not in a set. For information about 
pairing an Adapter set, see Problems with Pairing on page 42.
21
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Context Menu Options 

Menu Option Description

Block/UnBlock Device Allows you to temporarily disable a device from connecting with the PC 
Adapter. 

Disassociate Device Removes the device from the list. To return the device to the list, pairing must 
be performed.

Rename Allows you to change the device name as it appears on the Universal 
Push2TV HD Manager. 

Properties Displays the properties screen for this device. 

Configuring the Display 

Setting Options for the Display

The following are the suggested work configurations when you are connecting a display 
screen to the TV Adapter: 

•     Mirror Mode
•     Extend Mode
•     Laptop with Lid Closed
•     External Display Only

Note:  On Windows XP/Vista, the display properties for the HD Base can 
be configured in two ways: as described in Configuring the Display 
via the Display Icon Context Menu on page 26, or as described in 
Configuring the Display through Windows Display Properties in 
Windows XP/Vista on page 29. On Windows 7, see Configuring the 
Display in Windows 7 on page 24. 
 
When you change settings, or during first connection between the 
PC Adapter and the Universal Push2TV HD TV adapter, the PC 
display might flicker or turn on and off as the screen resolution is 
being automatically adjusted.

This section describes the different modes that can be set. Configuring the Display in 
Windows XP or Vista on page 26 and Configuring the Display in Windows 7 on page 24, 
describe the procedures for configuring these modes.
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Using Mirror Mode

Mirror mode is used to display the identical content on the additional screen as is shown on 
the main PC or laptop screen. Mirror mode is generally used to display the PC contents on a 
larger or higher-definition display. In Mirror mode, the default resolution is chosen based on 
the common denominator between the PC and the additional screen—therefore, for most 
PCs, 1080p is not supported. 

Note:  Mirror mode is not recommended for playing HD video.

Using Extend Mode

Using the system in Extend mode sets the wireless system to operate as an extension or as 
an additional screen to the PC. 

Instructions

Use the Extend mode to display different content on each display screen. In Extend mode, 
the display attached to the HD Base becomes an extended part of the Windows desktop. The 
extra desktop area is a great productivity aid, allowing you to view or work with more 
applications or documents at the same time. 

You can also use this mode to extend your desktop to fill multiple screens that are positioned 
next to each other for a larger continuous work space. 
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Note:  Extend mode is recommended for playing HD video as Mirror mode 
is limited by the resolutions supported in the PC.

Laptop Operation with the Lid Closed

You can work conveniently with a laptop by setting its default action upon closing the lid to Do 
nothing (to prevent the laptop from entering sleep or hibernation mode, select Control 
Panel > Power Options, "When I close the lid:" - "Do nothing"), and then set the HD 
Base screen as the primary display while disabling the main screen. 

The laptop lid can then be closed, and the laptop can be used with the HD Base screen and 
an external keyboard and mouse attached to the laptop. This configuration can be used 
together with either Mirror mode or Extend mode.

External Display Only

When you want to use the external display only, you can close your main monitor and view 
movies on the external display attached to the HD Base. 

Configuring the Display in Windows 7

Setting Mirror or Extend Mode in Windows 7

In Windows 7, there is a built in support for an external monitor. To use it, press the Windows 
key together with the P key ( +P), and the following menu displays:

For Mirror mode, select Duplicate.

For Extend mode, select Extend.
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Configure Screen Options in Windows 7

When a link is established with the Universal Push2TV HD TV adapter, the Display drivers 
are activated and the Display icon  appears in the Windows system tray. The right-click 
context menu of the Display icon contains configuration options that correspond to the 
display mode. 

To configure screen resolution, or any other display option, select Advanced. The following 
screen displays: 

To change any of the external display settings:

Select the appropriate display name in the Display list. You should select the name of the TV 
or monitor or projector connected to your HD Base.

Select the desired value in any of the available settings:

Resolution: Your external display resolution.

Orientation: Select either Landscape or Portrait.

Multiple displays: Select either Mirror or Extend mode.

Make this my main display: Mark this option to make the external display the primary 
display on which the desktop is displayed.
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Configuring the Display in Windows XP or Vista

Configuring the Display via the Display Icon Context Menu

Icon Context Menu in Windows XP or Vista

When a link is established with the Universal Push2TV HD TV adapter, the Display drivers 
are activated, and the Display icon  appears in the Windows system tray. 

The right-click context menu of the Display icon contains configuration options that 
correspond to the display mode. 

Note:  When changing settings, the PC display might flicker or turn on and 
off as the screen resolution is automatically adjusted.

Screen Resolution: 

The resolutions supported by the screen attached and the display adapter appear in the 
drop-down menu. This option is available in Extend mode only. In Mirror mode, the resolution 
supported by both screens is applied.

Color Quality: 

This option is available in Extend mode only. In Mirror mode, the color quality supported by 
both screens is applied. 
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Screen Rotation: 

This option allows you to rotate or flip the monitor. It is applicable in both Mirror and Extend 
modes.

Extend To: 

This option allows you to select the direction the monitor will extend to. 

Extend: 

Select Extend mode.

Mirror:

Select Mirror mode. 

Off:

Disable the remote display.

Advanced:

With this option, you open the Windows Display Settings screen and can select all display 
options from there. 

Setting Mirror Mode in Windows XP/Vista 

To set the display to Mirror mode:

Right-click the Display icon  and select Mirror from the context menu.
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•     The resolution, color depth, and refresh rate of the primary screen are duplicated on the 
display connected to the HD Base.

•     If the display connected to the HD Base supports a lower resolution than the primary 
display, the primary graphics device will have its resolution changed automatically to 
ensure that the whole picture fits on the additional display screen. 

•     If the display screen connected to the HD Base is larger than the primary screen, the 
image will be adjusted to a letter-box frame to preserve the correct aspect ratio. 

Note:  When you change from Extend to Mirror mode, NETGEAR 
recommends that you first set the display to Off, and then set it to 
Mirror.

Setting Extend Mode in Windows XP/Vista

To set the display to Extend mode: 

Right-click the Display icon  and select Extend from the context menu. You can also 
select the Extend To option to specify which side of the extended space is occupied by the 
extended display. 

Note:  When you change from Mirror to Extend mode, NETGEAR 
recommends that you first set the display to Off, and then set it to 
Extend.
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To place an application window in the extended space, use the following tips: 

•     Reduce the application window size to about half the normal size, and then drag the 
application window (dragging by the title bar at the top of the screen) past the edge of 
your main display and into the extended display space. Resize the window in the 
extended space as needed for comfortable viewing.

•     When dragging a running process window such as a movie or other application from the 
main screen to the extended screen, NETGEAR recommends that you pause or stop the 
running application first, and restart it in the extended screen.

Configuring the Display through Windows Display Properties 
in Windows XP/Vista
Display settings can also be configured from the Windows Display Properties dialog box. 

•     In Windows Vista: right-click the desktop, select Personalize > Display Settings. 
•     In Windows XP: right-click the desktop, select Properties > Settings. 

Selecting the Correct Display Monitor

In the monitor drop-down box, find the entry for the HD Base display monitor ...on 
DisplayLink Graphics. You can arrange this display's position with respect to the other 
monitors on the extended desktop by using the drag area at the top of the Windows Display 
Settings dialog box. If you are not sure which number represents which display, click Identify 
Monitors, and a large identifying number appears on each display.

Setting the Display to Extend or Mirror Mode

To set the display to Extend mode, check the Extend the desktop onto this monitor check 
box.

To set the display to Mirror mode, clear the Extend the desktop onto this monitor check 
box (see circle 1 in the previous figure).
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Adjusting Screen Resolution 

Use the Resolution slider to adjust the desired resolution of the display (see circle 2 in the 
previous figure).

Adjusting Color Level 

Use the Colors drop-down list to select a color complexity level (see circle 3 in the previous 
figure).

Setting the Universal Push2TV HD TV Adapter as the Primary Display 

To make the Universal Push2TV HD TV adapter the primary display:

1. Select the screen that is connected to the HD Base—for example, Default Monitor on 
DisplayLink Graphics Adapter, as shown in the previous screen.

2. Select the Extend the desktop onto this monitor check box. (In Windows XP: Extend my 
Windows desktop onto this monitor).

3. Select the This is my main monitor check box. (In Windows XP: Use this device as the 
primary monitor).

4. Click OK to save the new settings.

Note:  On some PCs it is necessary to disable the main display (clear the 
Extend the desktop onto this monitor check box for the main 
display) as part of the same settings change.  
 
The HD Base remains the primary one if the PC enters Hibernate or 
Suspend mode or is rebooted. If the HD Base is detached, the main 
display becomes the primary display again.
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Supported Resolutions 

Problem/Question:

I have a full HD TV, but I cannot set the screen resolution on it to 1920 x 1080, which is the 
native resolution of this TV.

Answer:

The maximum screen resolution supported by the product is 1080p (1920 x 1080). However, 
in Mirror mode you are limited by the maximum resolution of your PC. Therefore, you need to 
change the mode to Extend mode, as described in Configuring the Display on page 22. 

The Universal Push2TV HD TV Adapter Does Not Turn On

Problem/Question:

The Universal Push2TV HD TV Adapter does not turn on.

Symptom: 

No picture is displayed on the wirelessly connected screen/TV.

Solution:

Make sure the power cord is correctly connected to the base. Verify that the TV is set to the 
correct input (for example, HDMI1). This is done using the remote control of the TV. 
Additionally, follow the steps in the Installation Guide for hardware and software installation, 
and see Configuring the Display on page 22.

The Universal Push2TV HD TV Adapter Shows a “Ready to 
Connect” Message

Problem/Question:

The Wireless Laptop to Home Cinema shows a “Ready to Connect” message.

Symptom: 

A standard message is displayed on the wirelessly connected screen or TV.

Solution:

See Configuring the Display on page 22. Additionally, follow the steps in the Installation 
Guide for hardware and software installation.
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Driver Information

Verifying that the drivers are installed and functional.

Device Manager

Viewing the Drivers in the Device Manager

To view the drivers in the Device Manager, right-click My Computer and select Manage. 

In windows XP: 

In Windows 7:

1. Select Device Manager.
2. Select View > Devices by connection.
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Under PCI bus, open USB devices.

When the device is connected and all drivers are loaded correctly, you should get the 
following: 

If one or more of the drivers were not loaded correctly, they might appear with exclamation 
marks: 
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To repair this, right-click and select Update drivers, or uninstall, detach, and reattach the PC 
Adapter. 

Verifying WUSB Drivers Installation

Viewing the Drivers in the Installed Directory

Open C:\Windows\System32\Drivers, and look to see that the following files are there:

•     WSR_CBA.SYS
•     WSR_DWA.SYS
•     WSR_HWA.SYS
•     WSR_RCI.SYS
•     WSR_TBF.SYS
•     WSR_USF.SYS 

If any of the drivers are missing, uninstall and reinstall the Universal Push2TV HD drivers.
34



 Push2TV HD Adapter
Uninstalling Drivers
You can select Uninstall on the Device Manager as explained earlier.

To completely remove the driver installation: 

•     In Windows XP: Start > Control Panel > Add or remove programs.
•     In Windows 7: Start > Control Panel > Programs > Programs and Features.

Select the Universal Push2TV HD application, and uninstall it. Also, select the driver you 
would like to remove, such as Display Drivers:

Service Activation

In some cases, the drivers might be loaded, but the Display icon  does not display.

To make the Display icon visible:

1. Do one of the following:
•     Detach and reattach the PC Adapter.
•     Detach the PC Adapter and restart the PC.
•     Select Start > Computer > Device manager > Manage > Services and 

applications > Services.
2. Right-click the DisplayLinkManager and select Restart. 
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Viewing the Device’s Vendor ID and Product ID
Select the device in the Device Manager: 

Right-click and select Properties: 
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Select the Details tab and select Hardware IDs in the drop-down list: 

In the previous example: 

VID: 13CF

PID: 1200
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2.   Wireless Connectivity
This chapter describes common behaviors of your Universal Push2TV HD Adapter, and provides 
advice and solutions.

Wireless Icon Is Gray

Problem/Question:

The PC Adapter is attached to the PC, but I see the Gray icon in the System Tray.

Symptom: 

The host PC displays the Disconnected  (Gray) icon in the System Tray.

Solution:

•     Detach and re-attach the PC Adapter. 
•     Exit from the Universal Push2TV HD Manager (right-click the System Tray icon, and 

select Exit), and then restart the Universal Push2TV HD Manager. 
•     Detach the PC Adapter, restart the PC, and re-attach the PC Adapter. 

Wireless Icon Is Red

Problem/Question:

There are problems establishing a connection, and I see a Red icon in the System Tray.

Symptom: 

The host PC is showing the Disconnected  (Red) icon in the System Tray.

Possible Solution:

Check to see whether a device is connected: Right-click the System Tray icon, and select 
Universal Push2TV HD Manager to view the list of available devices and to see the green 
Connected icon next to the device name of the newly established connection.
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If either of the following happens, try the steps that follow:

•     Green System Tray icon  does not light up to indicate that a connection has been 
established. 

•     The Device is not listed in the Universal Push2TV HD Manager screen.

Power is not applied to the Device: Make sure that the appropriate power supply is 
connected to the power supply connector on the device side.

TV Adapter requires restart: Detach and re-attach the TV Adapter from the Display Adapter 
to restart the hardware.

Wireless Device is out of range: If you experience frequent wireless link disconnection, the 
Wireless Device might be out of range. Bring the Wireless Device closer to the Universal 
Push2TV HD PC Adapter.

TV Adapter requires pairing: If you are adding a TV Adapter that was not part of a set, or if 
you are connecting to a new unrecognized PC Adapter, you might need to perform the 
Pairing procedure. See Pairing on page 42.

Channel Busy

Problem/Question:

The Channel Busy message displays when I try to change the channel or after power-up or 
insertion of the PC Adapter.

Symptom:

The host PC is showing the Channel Busy  icon (Red with yellow exclamation mark) in 
the System Tray

Solution: 

Another wireless system might be in use in proximity to the PC or to the device’s 
environment, and might cause temporary interference with the Universal Push2TV HD 
system. Try to select a different channel (where applicable—local regulatory restrictions 
might apply).

Close the message box, detach the PC Adapter from your PC, and re-attach it. If the 
message displays again, try to change the channel again. 

Note:  Manual channel selection might be restricted by local 
communication regulation laws. 
 
In Europe, there is currently only one channel available, and when 
you try to use more than one set, they are trying to use the same 
channel. In general, they should be able to share the same channel.
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Movie Playing Is Disrupted

Problem/Question:

Movie playing is disrupted by moving the laptop. 

Symptom: 

Movie-playing performance is degraded when the laptop PC is moved around.

Solution: 

Some laptop models offer an active hard disk protection feature that locks the hard disk when 
motion is detected by the laptop. This might cause movie playing to be disrupted when the 
laptop is moved.

Disable or lower the sensitivity of the active hard disk protection mechanism.

Link Quality Indication

Problem/Question:

What are the different link quality indications? What do empty green bars indicate? 

Symptom:

Link quality indication shows empty green bars. 
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Solution: 

The following table shows the different states of the Connection Status icon, which indicates 
the connection quality:

State Icon Description

Blocked The device was blocked by the user and not connected to the PC.

Not connected The device is associated with the PC, but out of range.

Connected The device is connected with good link conditions, but no data is being transferred 
over the Universal Push2TV HD link.

Medium The device is connected with medium quality link conditions.

Good The device is connected with good quality link conditions.

Very Good The device is connected with very good quality link conditions.

Excellent The device is connected with excellent quality link conditions.

Universal Push2TV HD Range

Problem/Question:

What is the range of the Universal Push2TV HD Adapter? 

Answer:

The Universal Push2TV HD Adapter is designed for in-room usage.

Wireless connectivity is not expected to be available through walls (room-to-room).

The actual range depends on the visual content type and the system configuration:

Pictures, presentations, and standard Internet content with range >7m/20ft. 

720p/1080p video or Internet HD content with range of 5m/15ft.

Improved performance is achieved by positioning the dongles facing each other as much as 
possible, and at the same plane or height (also referred to as line of sight).
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Pairing

Problems with Pairing 

Problem/Question:

I’m having problems with Pairing.

Symptom:

The Pairing procedure does not result in the confirmation “Universal Push2TV HD device has 
been paired,” or it results in an error message. 

Solution: 

Try the following:

•     Detach and re-attach the TV Adapter.
•     Re-attach PC Adapter, and then attach TV Adapter.
•     Detach all Adapters, restart the PC, and try Pairing again.
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Multiple Hosts 

Problem/Question:

I’m having problems pairing with multiple hosts—each pairing must correspond to a specific 
PC Adapter (host).

Symptom:

If more than a single PC Adapter (Host) has been attached to the PC at any time, the pairing 
process requires that at least one PC Adapter be connected while the TV Adapter is being 
paired. 

Solution:

Make sure that a single PC Adapter is attached to the PC, and then re-attach the TV Adapter 
to perform pairing.
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3.   Video
This chapter describes the following topics:

•     General Troubleshooting 
•     Media Player 
•     Optimizing Internet Video 
•     Surfing the Internet Using Wi-Fi 
•     Playing Blu-ray 
•     Playing Video While PC Is Battery Operated 
•     Optimizing Video Performance Tips 
•     HDMI 
•     Picture Is Distorted When the Mouse Is Moving 
•     Using Skype 
•     No Display Icon 
•     Remote Display Appears Unstable 
•     External Display Is Not Activated 
•     Video Is Not Playing Smoothly 
•     Extend and Mirror Mode 
•     Using Extend Mode 
•     Screen Resolution in Mirror Mode 
•     Display Issues on TV 
•     Display Is Flipped 
•     Display Turns Black with Windows Media Player 
•     Text Does Not Show Properly While Video is Playing 
•     Video and Audio Synchronization 
•     Movie Playing Is Disrupted 
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General Troubleshooting

Minor issues can generally be resolved by any of the following:

•     Detaching and re-attaching the power from the HD base
•     Changing the display mode through the DisplayLink GUI
•     Changing the display mode through Windows Display Properties

On Windows 7 or Windows Vista WDDM (Aero and Basic), DisplayLink software works closely 
with the graphics card, and there might be interoperability issues with some graphics cards. If 
this happens:

1. Try to upgrade to the latest graphics drivers. This is also known as a GPU driver update 
(Graphics processing unit).

2. Try to upgrade to the latest DisplayLink software.

For further support and information about DisplayLink software, please visit 
http://www.displaylink.com/support.

Additionally, in Windows 7, NETGEAR recommends that you work in Aero Desktop Theme. For 
more information, see Aero Desktop Theme on page 55.

Media Player

Recommended Media Player Applications 
NETGEAR recommends that you use Power DVD, which can be downloaded from: 
http://www.cyberlink.com/downloads/trials/powerdvd/download_en_US.html?affid=
2581_853_290_12410_0_ENU_powerdvd&utm_source=
CLTR_PopularDownload&utm_medium=
CLTR_PopularDownload_12410_powerdvd&utm_campaign=CL_Trial

Though other media players, such as Windows Media Player or VLC, can be used, Power 
DVD has been seen to give the best combination of HD 1080p performance and Surround 
5.1 audio. 

Note:  For best performance, use Media Player in Extend mode. For 
additional information, see Configuring the Display on page 22. 

Media Player Configuration

The following steps describe how to set the Power DVD for surround audio. Check your 
media player documentation for the equivalent settings in order for the surround audio to 
work correctly.
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1. For surround audio to work correctly, click the Configure PowerDVD settings button 
(marked in the following figure). 

2. Select audio options in the left side of the window, and Use S/PDIF in the Speaker 
environment area. 
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3. Click OK to complete the configuration process. 

Recommended Codec Pack

For best performance when playing various video and audio formats, you should install an 
updated set of Codecs in the system.

The following set of Codecs has been tested and is known to give good video performance:

•     CCCP Codec Pack available from http://cccp-project.net/.

QuickTime Player with the Display Adapter

Problem/Question:

Video does not play correctly on Apple’s QuickTime Player.

Symptom: 

When you are using QuickTime Player, the video looks green or pink or does not play on the 
remote display. 

Solution:

Do one of the following:

•     Download the latest DisplayLink driver from 
http://www.displaylink.com/support/downloads.php.

•     Open QuickTime, and do the following:
1. Start > Program Files > QuickTime.
2. In the QuickTime application, select Edit > Preferences > QuickTime Preferences, 

and then switch to Safe Mode under the Video setting.
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WinAmp Application Does Not Return to PC Screen

Problem/Question:

I am using WinAmp, and when I change from Extended mode to Mirror mode, WinAmp is not 
being transferred to the PC screen and is not accessible.

Solution:

You should first drag the WinAmp application to the main display before switching to Mirror 
mode.

VLC Player Does Not Show Properly

Problem/Question:

I am using a VLC player in Windows XP, and there is distorted color and sound when I am 
working in Mirror mode.

Solution: 

Do one of the following:

•     Download the latest DisplayLink driver from 
http://www.displaylink.com/support/downloads.php

•     Make sure you have downloaded the latest version of the VLC player. If this does not 
resolve the issue, try using Power DVD, Windows Media Player, or another player 
instead.

Problem/Question:

I am using a VLC player, and when I switch from Extend mode to Mirror mode during movie 
play, the movie window shows a black picture only. 

Solution:

Close and restart the player after switching between the modes.
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Optimizing Internet Video

Internet Video

Optimizing Internet Video Viewing

Many video content websites use an embedded Adobe Flash player to show video content. 
In some cases to achieve best performance with the Flash player (for example, when viewing 
online video content in full screen mode), adjust the Flash Player settings as follows: 

To optimize the Flash player: 

1. Right-click the video content on the website, and select Settings from the Adobe Flash 
Player context menu. 

2. In the Adobe Flash Player Settings screen, clear the Enable hardware acceleration check 
box, and click Close to close the settings screen.

3. Resume viewing the video content.
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Online Movies Freeze

Problem/Question:

Online movies freeze in full screen mode.

Symptom:

The movie freezes when going to full screen mode on websites that use an embedded Adobe 
Flash player.

Solution:

In the Adobe Flash Player Settings screen, clear the Enable hardware acceleration check 
box. See additional suggestions in Internet Video on page 49 and Aero Desktop Theme on 
page 55.

Corrupt Picture While Playing Video on the Internet

Problem/Question:

I am watching a YouTube movie, and the picture is corrupted.

Answer:

When running flash-based viewers or real player-based viewers (such as YouTube or 
DailyMotion), play the movie after disabling hardware acceleration in the player. Right-click 
the video window, select Settings, and select the Disable the hardware acceleration check 
box. Or right-click an available area on your desktop, and select Properties.
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Select the DisplayLink display card:

Select Advanced > Troubleshoot, and disable the hardware accelerator:
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Another option is to right-click the Video screen, select Settings, and clear the Enable 
hardware acceleration check box:

Flash Player Is Not Showing in Full Screen

Problem/Question:

I am watching a movie with Flash Player, like YouTube, in full screen. When I click the mouse, 
the screen changes back to a smaller screen. 

Answer:

When you are running Flash Player in one screen and you click the mouse in another 
window, the Flash Player returns to normal screen display mode. This functionality is defined 
by the player application and behaves the same way in any extended monitor, not related to a 
wireless or a USB connection.
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Surfing the Internet Using Wi-Fi

Problem/Question:

Can I simultaneously surf the Internet using Wi-Fi and view it wirelessly on my HD TV using 
the Universal Push2TV HD Adapter, for a complete wireless Internet display on my TV?

Answer:

Yes, you can. Using the home or office Wi-Fi network and the Universal Push2TV HD 
Adapter simultaneously is possible without any degradation of the network speed or the 
video quality. You can view your favorite web content (videos, news, TV channels, or even 
Skype calls) on your HD TV. This configuration allows you to easily have wireless Internet on 
your TV without being limited to specific websites or content. You can do so while using your 
favorite browser that you use for surfing the Internet, with no additional cost and with the 
enhanced convenience provided by the fully wireless connectivity. This is the best and 
easiest Web-to-laptop solution available in the market.

Playing Blu-ray

Problem/Question:

Blu-ray playback will not play on the remote screen. 

Answer: 

Blu-ray playback is not supported.

Playing Video While PC Is Battery Operated

Problem/Question:

Video performance is degraded when the PC is powered by batteries.

Symptom:

When you disconnect the power supply from a laptop PC and the PC is battery operated, 
Video quality is degraded (frames per second is reduced and the picture is jittery).
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Solution:

In some cases, the operating system is adjusting the CPU clock to a lower performance 
mode while the PC is battery operated. It is possible to detect this by viewing the system 
parameters of the PC: Right-click My computer, and select Properties. 

If the CPU speed is reduced from its AC power operation performance, set the PC to operate 
in maximum performance mode.

This setting might change from one PC model to another. Refer to the PC user manual or 
Help for specific instructions.

In most cases, you can double-click the Battery Icon in the system tray, and select the Power 
scheme and the maximum performance option.

Optimizing Video Performance Tips

Using Optimize for Video Mode
For best performance watching a video when using the Universal Push2TV HD Adapter, use 
the Optimize for Video mode. 

This mode is available in Windows Vista and Windows 7 only. 
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Right-click the Display icon , and select Optimize for Video. 

Note:  As this mode is optimized for video watching, quality of text might be 
degraded.

Aero Desktop Theme

Setting Aero Desktop Theme in Win7

When you use the Universal Push2TV HD Adapter with the Windows 7 operating platform, 
NETGEAR recommends that you use the Aero desktop theme. Other desktop themes will 
result in poor video performance.

To set the desktop to the Aero theme in Windows 7:

1. Right-click the desktop, and select Personalize.
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2. In the Control Panel > Personalization screen, select Windows Color and Appearance.

3. Select Windows Aero (or other) from the Color scheme list, and click OK to save the new 
setting. 

HDMI

Display Size on TV 

Problem/Question:

•     I am connected to my TV in HDMI mode, and the picture on the TV is too big (only part of 
my laptop screen is showing).

•     I am connected to my TV in HDMI mode, and the picture on the TV is too small (black 
areas are seen around the picture). 

Answer:

In some cases, with different TV brands, the TV is set up by default to a specific resolution, 
and does not scan the HDMI for supported resolutions. Try the following solutions:

•     This can usually be resolved by opening the TV setup screen and looking for a method for 
enabling the HDMI scan (or switching to PC mode if available). If this mode is not 
available, try to select different screen resolutions in the TV until you find one that fits the 
resolution you have selected on your laptop screen settings. 
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•     When using Extend mode, change the resolution using Display Link Manager. For more 
information, see Configuring the Display on page 22.

•     Download the latest Display Link driver.

Picture Is Distorted When the Mouse Is Moving

Problem/Question:

I am changing from Extend mode to Mirror mode during movie play, and there is a paint effect 
on the movie window—the picture is frozen, and is updated only where the mouse is moving.

Answer: 

Close and restart the media player.

Using Skype

Problem/Question:

I am using Skype for Web video conferencing, and it is working only in Extend mode. In 
Mirror mode, there is some corruption (paint effect) on the picture. 

Answer:

Make sure you are using the latest version of Skype.

Note:  Skype Video is supported in Windows Vista and Windows 7 only.  
In Windows XP, the remote video might appear black.

This might be solved by disabling the hardware accelerator, as described in Corrupt Picture 
While Playing Video on the Internet on page 50.

No Display Icon

Problem/Question:

The picture disappeared and the Display icon is not displayed in the System Tray.

Symptom:

The Display icon  is not displayed in the System Tray.
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Solution:

•     Detach and re-attach the power supply of the Base Adapter.
•     Detach and re-attach the PC Adapter to restart the adapter hardware.
•     Reset the PC, and try again to establish the wireless connection to the HD Base. 
•     Installation was not completed successfully. Uninstall both wireless and DisplayLink 

drivers and reinstall.
•     See also Service Activation on page 35.

Remote Display Appears Unstable

Problem/Question:

My remote display appears slightly shaky.

Answer:

Make sure the screen refresh rate is set correctly and is not too low.

Right-click the desktop, and select Properties > Settings.

Click Advanced, and select DisplayLink as the graphic card:
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Select monitor and adjust the refresh rate:

External Display Is Not Activated

Problem/Question:

The External Display is not activated.

Symptom:

No image is displayed by the remote screen (external display). 

Solution: 

Check to see that the video cable between the HD Base and the display screen is connected 
correctly and securely. 

Make sure that you have selected the correct input source in the display screen or TV 
controls (for example, HDMI, Line In, and Digital Input).

Check to see that the power supply to the display screen is connected correctly.

Make sure that the Screen Resolution that is set on the PC is supported by the external 
display. 

For more information, see Configuring the Display on page 22. 
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Video Is Not Playing Smoothly

Problem/Question:

I see dropped frames and/or audio/video disconnects during movie play.

Answer:

There are several things that can cause this:

•     Your PC might not be powerful enough (the CPU usage seen in the Task Manager tool is 
80-100%). See Minimum System Requirements on page 6. 

•     Changing screen resolution to 720p (instead of 1080p). Select 1280×720, as described in 
Configuring the Display on page 22.

•     For watching video, NETGEAR recommends that you put the Universal Push2TV HD 
adapter into Extend mode. For more information, see Configuring the Display via the 
Display Icon Context Menu on page 26 or Configuring the Display in Windows 7 on 
page 24.

•     When you are viewing streaming video from the Internet, especially in Full Screen Mode, 
NETGEAR recommends that you optimize the signal by disabling the hardware 
acceleration. For issues related to streaming from the Internet, see Internet Video on 
page 49.

•     No line of sight between the laptop and the base, which causes slight degradation in 
throughput and can cause such issues. Try to improve the line of sight between the TV 
and laptop and see if it helps.

•     The laptop is too far away from the base, causing a drop in throughput. Try to get closer 
to the TV and see if this helps. 

•     When using Windows Vista or Windows 7 and watching videos, you should enable 
Optimize for Video mode, using the DisplayLink Manager icon in the task bar. For more 
information, see Using Optimize for Video Mode on page 54.

•     When using Windows 7, use Aero Desktop Theme. For more information, see Aero 
Desktop Theme on page 55.

Extend and Mirror Mode

Problem/Question:

What is the difference between Mirror mode and Extend mode?

Answer:

In Mirror mode, what you see on the notebook screen is also seen on the TV (including 
icons), while in Extend mode the remote display extends your notebook screen (excluding 
icons). In Extend mode, you can let your family or friends watch a movie streaming from your 
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laptop onto your HD TV, while you can continue working on your documents, emails, and 
Facebook account displayed on the laptop screen. 

Using Extend Mode

Problem/Question:

How do I use my system in Extend mode, and how do I set the wireless system to operate as 
an extension or additional screen or display to the PC? 

Instructions:

Use Extend mode to display different content on each display screen. In Extend mode, the 
display attached to the HD Base becomes an extended part of the Windows desktop. The 
extra desktop area is a great productivity aid, allowing you to view or work with more 
applications or documents at the same time. You can also use this mode to extend your 
desktop to fill multiple screens that are positioned next to each other for a larger continuous 
work space.

Note:  Extend mode is recommended for playing HD video, and lets you 
use a second display for an additional application or a movie.
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Note:  When you are changing settings, or during first connection between 
the PC Adapter and Base Adapter, the PC display might flicker or 
turn on and off as the screen resolution is automatically adjusted.

Detailed instructions on how to set your PC to work in Extend mode are in Configuring the 
Display on page 22. 

Screen Resolution in Mirror Mode

Problem/Question:

I am working in Mirror mode and when the device connects, the screen resolution changes 
from the original native resolution on both my TV and my laptop. 

Answer:

This is normal when working in Mirror mode as the system is using a common resolution for 
the laptop and the TV because it needs to display an identical picture on both. In Extend 
mode, it is possible to play with the screen resolution of each individual screen, using the 
Windows screen settings.

You can go to the Display setting on your laptop PC and change the resolution back. 
Right-click an available area on your desktop, and select Properties.
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You can change the screen resolution, currently set to 1024 x 768:

Display Issues on TV

Problem/Question:

•     I am connected to my TV in HDMI mode, and the picture on the TV is too big (only part of 
my laptop screen is showing).

•     I am connected to my TV in HDMI mode, and the picture on the TV is too small (black 
areas are seen around the picture).

Answer:

In some cases, with different TV brands, the TV is set up by default to a specific resolution, 
and does not scan the HDMI for supported resolutions. Try the following solutions:

•     This can usually be resolved by opening the TV setup screen and looking for a method for 
enabling the HDMI scan (or switching to PC mode if available). If this mode is not 
available, try to select different screen resolutions in the TV until you find one that fits the 
resolution you have selected on your laptop screen settings. 

•     When using Extend mode, change the resolution using Display Link Manager. For more 
information, see Configuring the Display on page 22.

•     Download the latest Display Link driver.
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Display Is Flipped

Problem/Question:

I am connected to my TV in HDMI mode. I can get a correct display and sound if I use the 
Extend display option in the Windows 7 Screen Resolution window, but if I try to display the 
whole desktop on the TV using “show desktop on 2,” the display is upside down. 

Answer:

You might have selected Landscape (flipped) in the Screen Resolution window.

Display Turns Black with Windows Media Player

Problem/Question:

I am using Windows Media Player, and sometimes during movie play in full screen mode the 
Media Player application window becomes black. 

Answer:

Try re-sizing the application window. This should resolve this issue.

Text Does Not Show Properly While Video is Playing

Problem/Question:

I am watching a movie on my TV while having a second application open (for example, Word 
or Excel) in another window, and the fonts flicker between sharp and fuzzy. 

Answer:

Disable the Optimize for Video option from the DisplayLink icon in the taskbar because it 
applies compression to the text, resulting in the issue you described. For more information, 
see Using Optimize for Video Mode on page 54.

Video and Audio Synchronization

Problem/Question:

Audio is not synchronized with the video.
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Symptom:

When you play a video, the audio part of the playback might not be synchronized with the 
video playback.

Solution:

Change the active power plan to Always On, Balanced, or High Performance.

Windows XP: Click Start, select Control Panel. Click Power Options. Under Power 
Schemes, select Always On.

Windows Vista: Click Start, type power in the Start Search box, and then click Power 
Options in the Programs list. Under Select a power plan, click Balanced or click High 
performance.

Problem/Question:

I am watching a movie on my laptop, and there is a synchronization issue between the audio 
and the video.

Answer:

With some of the Codecs available for download, the audio and video are not in sync when 
you enlarge the screen—there is a delay in the video. Try downloading a different Codec and 
try again. One that is known to work correctly can be downloaded from the following location: 
www.cccp-project.net.

To prevent audio-video synchronization issues (lip sync), make sure that the active power 
plan in your PC is set to either Always On in XP, or in Vista, to Balanced or High 
Performance.

Movie Playing Is Disrupted

Problem/Question:

Movie playing is disrupted by moving the laptop. 

Symptom:

Movie-playing performance is degraded when the laptop PC is moved around.

Solution:

Some laptop models offer an active hard disk protection feature that locks the hard disk when 
motion is detected by the laptop. This might cause movie playing to be disrupted when you 
move your laptop.

Disable or lower the sensitivity of the active hard disk protection mechanism.
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4
4.   Audio
This chapter describes the following topics:

•     No Audio in HDMI Connection 
•     Audio Disappears After Link Disconnection 
•     Audio Does Not Switch to TV or Screen 
•     Setting Audio Output Device 
•     Video and Audio Synchronization 
•     Audio Control Using the PC Buttons 

No Audio in HDMI Connection

Problem/Question:

No audio on the remote TV.

Symptom:

The system is connected and a movie is playing, but no sound is coming out of the TV 
speakers.

Solution:

1. Install the media player recommended applications listed in Recommended Media 
Player Applications  on page 45. 

2. Configure the media player as defined in Media Player Configuration on page 45. 
3. You might need to manually configure the PC audio output, as described in Setting Audio 

Output Device on page 67. Vista/Windows 7 users must configure the audio device for 
either digital or analog output as described there.

4. Some TVs require you to select the audio input source—verify that digital audio source is 
selected using the TV remote control.

5. Restart the media player after any change in the configuration of the system. 
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Audio Disappears After Link Disconnection

Problem/Question:

Audio does not recover after the link disconnects and reconnects.

Symptom:

I am watching a movie or a YouTube clip, and suddenly there is a disconnect/reconnect, after 
which the sound does not come back to the TV.

Solution:

This can happen (mostly in Vista) because after the movie has started, most video players do 
not transfer the audio back to the USB audio device after the reconnect.

Usually restarting the player or refreshing the web page resolves this.

If that still does not help, try unplugging the PC dongle and then plug it again. Wait for the 
connection to be reestablished, and start the movie again.

You can also see Setting Audio Output Device on page 67.

Audio Does Not Switch to TV or Screen

Problem/Question:

Audio remains on the PC sound device and does not switch to the TV or screen. 

Symptom:

I have started watching a movie or clip on the Internet, and then connected the Universal 
Push2TV HD Adapter laptop dongle. The picture is showing on my TV, but the sound did not 
switch to the TV.

Solution:

Restart the player or refresh the web page after connecting the dongle, to allow the default 
audio device to switch to the USB audio device. This does not always happen automatically 
after the player or web page was already activated. 

You can also see Setting Audio Output Device on page 67. 

Setting Audio Output Device

The PC audio output device should set itself automatically to the connected Universal 
Push2TV HD Adapter C-Media audio device. If it does not, you can select the correct audio 
playback device as follows:
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In Windows XP:

1. Right-click the Volume icon in the System Tray and select Adjust Audio Properties.
2. In the Sounds and Audio Devices Properties screen, click the Audio tab.
3. Under Sound Playback, in the Default Device drop-down list, select USB PnP Sound 

Device.
4. Click OK to save the new setting.

In Windows Vista/Win7:

Right-click the Audio icon in the System Tray  and select Playback 
devices. 
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If using HDMI or S/PDIF (Digital output):

Click Digital Output USB PnP Sound Device, and click Set Default. 

If using 3.5 mm jack (Analog output):

Click Speakers USB PnP Sound Device, and click Set Default. 
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Video and Audio Synchronization

Problem/Question:

Audio is not synchronized with the video.

Symptom:

When you play a video, the audio part of the playback might not be synchronized with the 
video playback.

Solution:

Change the active power plan to Always On, Balanced, or High Performance.

Windows XP: Click Start, and select Control Panel. Click Power Options. Under Power 
Schemes, select Always On.

Windows Vista/Windows 7: Click Start, type power in the Start Search box, and then click 
Power Options in the Programs list. Under Select a power plan, click Balanced or click High 
performance.

Problem/Question:

I am watching a movie on my laptop, and there is a synchronization issue between the audio 
and the video.

Answer:

With some of the Codecs available for download, the audio and video are not in sync when 
you enlarge the screen—there is a delay in the video. Try downloading a different Codec and 
try again. One that is known to work correctly can be downloaded from the following location: 
www.cccp-project.net.

To prevent audio-video synchronization issues (lip sync), make sure that the active power 
plan in your PC is set to Always On in XP, or in Vista, to Balanced or High Performance.
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Audio Control Using the PC Buttons

Problem/Question:

The volume control works only on the TV remote control or on the Audio receiver and not on 
the laptop buttons.

Answer:

•     For stereo audio, it is a known Microsoft operating system bug that on some PCs certain 
volume buttons do not work for USB Audio devices. On some of them, the mute works 
but the volume control does not.

•     For surround audio, by definition, volume level cannot be configured through the media 
player or OS control, but rather only on the audio receiver or home theater system audio 
control buttons.
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5
5.   Miscellaneous
This chapter describes the following topics:

•     PowerPoint in Extend Mode 
•     Power Saving Modes and Screen Saver 
•     Built-In Laptop Screen Remains Black 
•     PC and TV Adapters Are Warm 

PowerPoint in Extend Mode

Problem/Question:

Slide show is displayed on the main monitor only.

Solution:

This is a PowerPoint configuration feature. Slide show can be displayed on the main or 
secondary monitor as selected:

You can show it in presenter view on one screen and as a slide on the other by selecting this 
view. 

As an alternative, in PowerPoint, the Display slide show on: menu does not work when there 
are gaps in the numbering of enabled displays. Users of PowerPoint 2007 can get around 
this by using Show presentation on: in the ribbon, rather than the Set up slide show dialog 
box. 
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Power Saving Modes and Screen Saver 

Problem/Question:

When I exit from screen saver mode, I notice strange effects on the remote display.

Solution:

Sometimes it is necessary to detach and reattach the PC Adapter after exiting the screen 
saver. 

Problem/Question:

When my computer enters screen saver mode, I notice some flickering or decreased 
graphics performance.

Solution:

That is a known issue when screen saver mode is using 3D figures. Change the screen saver 
so it does not include any 3D figures.

Problem/Question:

When I exit from screen saver mode, there is no audio.

Solution:

You might have to restart your media player for the audio to start playing on the remote 
stereo speakers or home theater system.

Sometimes it is even necessary to detach and reattach the PC Adapter after exiting the 
screen saver.

Built-In Laptop Screen Remains Black 

Problem/Question:

After I set my laptop to “when close lid, do nothing,” when I close the lid and open the lid back 
up again, the built-in screen remains black.

Solution:

This is a known bug. Use the Display Link UI or Windows Display Properties to re-enable the 
built-in screen.
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PC and TV Adapters Are Warm

Problem/Question:

Using the system, the PC and TV Adapters get extremely hot.

Solution:

This is known and normal. The system was tested for hours in extreme conditions and 
continues to operate normally although the two adapters seem to be warming. 
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